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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

¢ Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.

In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contrdleur.
Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Ardbox sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Ardbox.

En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de |'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging - Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.



10.1
10.2

11.
12.
111

11.2
11.3

13.
14.
15.
16.
17.
18.

Table of Contents

Ardbox Analog HF: General FEatures.......cocuieeeiieiie ittt s 9
Technical SPeCIfiCatioNS .....cccvvieeciie e 10
General SPeCifiCatioNS: ... .iic e 10
Performance Specification: .........coeoeciiee i 10
13712 o] [} LV SRS 11
PreCaULIONS .ot e e e e e e s st e et e e e e e e s et barreaaaees 12
ArdUINO BOArd .....eeeiiiiiieeeieee et e e e e e e e e e e e e e e e e e eeeans 12
T =Y gTo LYo XU o 1T Vol SR 12
GeNeral PreCaULIONS .....cccuviieiee et cee et e s e s sen e e snree e 12
SOFtWAIE INTEITACE ... ee ittt e ee e e e rae e e nneas 12
How to connect PLC Arduing t0 PC......coiiiiiiiiieiiiee ittt eeee e s saee e 15
How to connect PLC t0 POWET SUPPIY coeeeiviieiiceiieee ettt nne e 16
Ardbox ANAIOE /O PINOUL: c...ecccviiiieeecree ettt ettt e ste e e sbeeeeareeebeeesnree s 18
o] o 1= ©e] o o =T o1 d o o -SSP 18
Y21 el g I oo Y g ¥ i F={U [ = 4 o] o A USRN 20
General Switches Configuration.........cccvcioreerie it 20
RS- 485 Switch configuration ...........coccvveeiieeeiieccie e e 22
RS-232 Switch configuration .........ceeevee e 23
[2C SWitch coNfigUration ......ccccueei e et 23
JUMPEr CONFIGUIATION....ceeieeeiie et e et e e e 24
Hardware Serial RS-232 & RS-485 Configuration........cccceeeivciveeeicciieee e 25
Hardware Serial RS-485.......coo ittt e e raee e e e abaae e 25
Hardware Serial RS-232.......coi ittt raee e e e eabaee e 26
GPRS/GSIV..eii ittt ettt ettt ettt bt st e e e s te s re et e s be et e s teeaa e beeae e tenreenaenes 27
Ardbox - Arduino 1/OS 5V PINS....cccuieiriecieeeiicireeiteecreeereeete et eaeceveesteeetveeveeereeereeeans 28
[2C PINS = SDA/SCL weoetieeieetie et cte ettt et teete e s teesta e et e e baesbeesabeesteebeassaesnneans 29
T T TSR 29
SPI— MISO/MOSI/SCK ..ottt ettt ve sttt be s b b be e esa e beenne s 29
1/0 TECINICAL ETAIIS ..ot e e e e e et e e e e e eeeeeerareneeeeann 29
TYPICAl CONNECLIONS .eeiiieeeeecieee ettt e e e e e et re e s e sraaae e e e sbbeeee e saneaeasnans 32
(00T oo =Tot oY gt [=] =1 3PS 35
ARDBOX Family DimMENSIONS:...c..ccuvieieieiriieeiiiiieeeeesiieeesseiree e e ssveaeessseneeeessnsaneessnnnnees 36
DIN rail MOUNTING: ..ooeiiie ettt ettt st et st sneeaae e 36

VT (o] T =1 o] [T RRRRRRORPRPRNY 37



1. Ardbox Analog HF: General Features

Supply Yoltage

24 \/cc

1/Os

Digital
Analog

Relay

COMPACT PLC ARDUINO ARDBOX 201/0s

(0-10Vce)

Analog Output 8bit

ANALOG HF
Fuse protection (2.5A)
Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30w
I Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
. . I12C -- USB -- RS232 - RS485 —
Communications SPI — TTL — GPRS RS485
TOTAL Input points 10
TOTAL Output points 10
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vce) 7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input olesdcs 7 to 24Vdc
I min: 2 to 12 mA | min: 3/6 mA
HS Galvanic Isolation Se arated PCB ground
(24Vce) Rated Voltage: 24Vdc P grou
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

(24Vce)

Digital Isolated Output

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

8bit (24Vcc)

PWM Isolated Output

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM Isolated
Output 8bit (24Vcc)

Expandability

12C — RS232 — RS485 — SPI - TTL
- GPRS

Reference

006001001200




2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply 12t024Vdc ===
Operating
voltage range DC power supply 1141t0254Vdc ===
o DC power supply 30VAC max.

consumption

Power supply voltage 24Vdc ===

External
power supply Power supply output 700 mA
capacity
. . 20MQ min. at 500Vdc between the AC terminals and the protective ground
Insulation resistance ;
terminal.
2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
Dielectric strength max. Between all the external AC terminals and the protective earth
terminal.
Shock resistance 80m/s? in the X, Y and Z direction 2 times each.
Ambient temperature (operating) 0° to 60°C
Ambient humidity (operating) 10% to 90% (no condensation)
Ambient environment (operating) With no corrosive gas
Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2 Performance Specification:

Arduino Board ARDUINO LEONARDO
Control method Stored program method
/0 control method Combination of the cyclic scan and immediate refresh processing methods.

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
Programming language composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/lHomePage

Microcontroller ATmega32u4
Flash Memory 32KB of which 4KB are used by bootloader
Program capacity (SRAM) 2.5KB
EEPROM 1KB
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Clock Speed

16MHz

2.3 Symbology

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / . . .
WE— | oohical symbols | 5031/ Direct | ndicates that the equipment is
HEE B Em suitable for direct current only;
for use on Current ; . :
X to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols . suitable for alternating current
N for use on 5032 C/:Alternatlng only; to identify relevant
; urrent .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To Ildentlfy the .control by
for use on which a pulse is started.
: General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 50237 / Earth, neither the symbol 5018 nor
‘ X round . . )
equipment 5019 is explicily required.
IEC 60417/ . . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115 / Slgnal lamp : .
X lamp(s) is (are) switched on or
equipment

off.

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking . )
93/42/EEC applicable Eurqpean Union
regulations
ISO 7000/ Indicat Al
Graphical symbols naicates a pcl)tentla'y .
F 0434B / hazardous situation which, if
or use on . ) ;
X Warning symbol not avoided, could result in
equipment ; .,
death or serious injury
ISO 7000/
Graghlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
X Voltage from dangerous voltages
equipment

11




3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Analog HF GPRS and follow its
descriptions for reference during operation.

3.1  Arduino Board

The ARDBOX 20 I/Os Analog HF GPRS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 I/Os Analog HF GPRS under different conditions from what has been
specified in this manual or integrating ARDBOX 20 I/Os Analog HF GPRS to nuclear control
systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

12



Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences x

Settings  Networl:

Sketchbool: location:

C:\Users\Alber tiDocuments\Arduino Browse
Editor language: English (English) | (requires restart of Arduino)
Editor fort size: 15

Interface scale:

utomatic | 100 T %  (requires restart of Arduing)
show verbose output during: [<] compilation ] upload
Compiler warnings: None

[Ipisplay line numbers

[CJEnable Code Folding

Verify code after upload

[[Juse external editor

Check for updates on startup

Update sketch flles to new extension on save (;pde -> (ino)

Save when verifying or uploading

Additional Boards Manager URLs: |hiip://apps. indusirialshields. com/main/arduino boards/package_industr alshields_inde | [C1

fdl
C:\Users\albertysppDatall ocal\Arduino 15\preferences. tt

it only when Archiino is not running)

Iy in the file

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields

index.json

3. Press OK to save the changes.

4. Goto: Tools -> Board: ... -> Boards Manager

D sketch_mar16a | Arduing 1,80

File Ecit Sketch Tools Help

Auto format [
oonm Auchive Sketch
Fix Encoding & Reload

Sernal Monstor CulasiiftsM
b Sertal Plotter CuleShittel
WFi 101 Firm ware Updiater

Boarct "M-Duino tamily" i
inchustial Shaeids: h-Duino 56+

Get Board Infa

Arduino Duemilanave or Diecimila

Programmer: “Arduino as ISP
Bum Bootioader

Arduino Nano
Arduino/Genng Mega o Mega 2560
Arduino Mega ADK
Arduing Leanardo
Arduing Leanardo ETH
Arduino/Genuing Micro
Arduing Esplora
euino Wik
Arduino Ehernet
Arduing Fio
Arduino BT
LilyPad Arcuin USB
LilyPad Arduino
Arduing Pro or Pro Min
Arduino NG or ofder
Ardune Rabot Control
Arduing Robot Motor
Arduino Gemma
Adatruit Circuit Playground
Arduino ¥iin Mini
Arduing Indussial 101

Linimo One
Arduino Uno WiFi
Inciustal Shistd
Ardbox family

& M-Dun family
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5. Search for industrialshields.

& Boards Manager

Type All | |industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

Install

Close

6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

@ sketcn_aug26s | Arouina 189

File Edit Sketch Tools Help

Auto Format

Archive Skatch

Fix Encoding & Reload
Manage Librariés..
Serial Monitor

Serial Plotter

WIFI101 / WIFININA Firmware Updater

Board: “Ardbox WiF/BT family”

Get Board Info

Pragrammer: “Ardhing Gemma®
Burn Bootiaader

Modek,"Argbox Analog HF+ wf HW RS-232 WiFi/BT

et

CulaShifte!
Cirt+Shift=M
Cirl+Shift=L

- o %

Boards Manager.
4

MEStack FIRE

MSHCK-C

ODROID ESP32

Heltee WiFi Kit 32

Heltes WiFi LoRa 32

Heltee WiFi LoRa 32(v2)

Helter Wireless Stick.

ESPectrod2

Microduing-Core€srsz

ALKS ESP32

WiPy 30

8p1-eIT

Silicognition wESP32

T-Beam

D-tuino-32

Lody

Lopya

ORDCA EduBor

£5932 FM Daviit

Frog Board ESP32

A1 Thiiker ESP32-CAM

Sparkfun LoRs Gateway 1-Channel

Wi modile

Mo family
Ardbox GPRS famity

181 Acabox WIFU/BT family
M-Duino family
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Once it is selected the Ardbox Family or Ardbox GPRS family an extra option will
appear on Tools:

- Select the correct Ardbox GPRS Board (Ardbox Analog HF+ w/HW RS-232 GPRS or
Ardbox Analog HF+ w/HW RS-485 GPRS) depending on your jumpers & switch
configuration.

WIFHO1 / WIFININA Firmware Updater

Board: “Ardba WiF/BT tamily’ x

Magel: "Arbax Anaiog HE + wi HW RS-232 WiFi/BT 38 Ardbox Analag HF= w/ HWW RS-232 WiFi/8T
Aucbox Analag HF+ w/ HW RS-485 WiF{/BT
Asdbox Relay HF + w/ HW RS-232 WiFi/BT

. Audbox Refay HF-+ w/ HW RS-435 W /BT

Loop()

Get Bo

Also there are some examples of programming in File -> Examples -> Ardbox Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://qgithub.com/IndustrialShields/

5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family

- Select correct port.

15



Senil Patter Cotssnifid

COMI3 (Arduno Leonardol

Now everything is set up to upload a sketch to Ardbox Analog HF w/GPRS

6. How to connect PLC to power supply

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[::"e; SEP L:l
h GND I

I—* ol 4105 |

s |
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- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

ﬁﬁ §:--F ﬁ [

the power supply is certified according to UL. Din RAIL Power Supply, ac-dc,

30W, 1 Output 1.3A at 24Vdc

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

17



7. Ardbox Analog I/0 pinout:

7.1  Zone Connections
LEFT ZONE
5 &
o

58 | 2 $

a g S 3]

28 |8 Z

A0.6" 3 Analog Out

A0.5 5 Analog Out

A0.4" 6 Analog Out

A0.3' 9 Analog Out

A0.2" 10 Analog Out

A0.1" 11 Analog Out

A0.0 13 Analog Out

Q0.9° 1 Digital Output

Q0.8% 0 Digital Output

Q0.7 7 Digital Output

Q0.6’ 3 | PWM/digital Output

Q0.5 5 PWM/digital Output

Q0.4 6 | PWM/digital Output

Q0.3 9 PWM/digital Output

Q0.2 10 | PWMIdigital Output

Q0.1 11 PWM/digital Output

Q0.0 13 | PWMrdigital Output
GNDCOM - Isolated GND
24VCOM - Isolated VIN

o0Qo|jpooT
[sX=X=1] =X=X=)

Q0.0

A0.6
A0.5
AO.4
A0.3
AO0.2
AO.1

AQ.Q

-~
g
f

N0

Q0.9
Q0.8
Q0.7
Q0.6
Q0.5
Q0.4
Q0.3
Q0.2
Q0.1
Q0.0

GNDCom

24VCom

GND
24V

WPAVZ-ZL

1444444444

! See section 8 to enable these connections

2 See section 9 to enable these connections

LEFT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Analog Outputs pins

Digital Outputs pins

Power supply connectors
(24vdc - GND)
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RIGHT ZONE

— c * (=33
§ | 8% |ed :
x 9 ) o S
o9 c N c v o
8¢ SHEE i
o Ty |2q 5
<O <X <X [
A+ - - RS485(A)
B-'? - RS485(B)
Y+ - - RS485(Y)
z-'? - - RS485(Z)
SCL-PIN3' 3 3 SCL(12C)
SCL-RST GPRS' 2 2 RESET GPRS
TX-R$232"2 1 4 -
RX-RS232"? 0 8 -
5V - - 5Vout DC
RESET - - RESET
SCK - - SPI
MOSI GPRS GPRS SPI
MISO GPRS GPRS SPI
10.9 18 18 Analog/Digital Input
10.8 19 19 Analog/Digital Input
10.7 20 20 Analog/Digital Input
10.6 21 21 Analog/Digital Input
10.5 22 22 Analog/Digital Input
10.4 23 23 Analog/Digital Input
10.3' 8 8 Digital Input
10.2' 4 4 Digital Input
10.1 12 12 Digital Input
10.0' 2 2 Digital interrupt

HS*: Hardware Serial

SS*: Software Serial

COMUNICATION SWITCH

*See Ouput Switch
Iz?gl

GND=—]

L. S—
DE-RS485
AD2-Q02*
RX-RS485
A0.1-Q0.1*
SCL-D2/10.0

SDA-D3/ Q06
OFF . ON

B-
Y+
Z-

A+
g
4

Halt/Ful

SCL-PIN3
SDA-PIN2

12¢-ss

NC

! See section 8 to enable these connections

2 See section 9 to enable these connections

RIGHT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/Os)

Communications pins

Digital/Analog Inputs

NOTE: Although in the serigraphy it is not shown the RS232 communication pins, in the reality it
exists. The change that has to be done is the following:

(see section 8 for communications
configuration)

§ [P DEFAULT SERIGRAPHY CORRECT SERIGRAPHY
§ | SDAEINZ SDA-RST GRPS SDA-RST GPRS
NC NC TX-RS232
GND
5V NC RX-RS232
- GND GND
S
3groszamE e o
O Q:0 O[Q|[0 © 0,0 O] 9 4
£ — s O &y
O 0RO O QJlojo 00 ¢ | W A\
[ e R R R ) e T N RERET
== == o/o o o O
Config switch * Input / Output Power LED Arduino Reset

button
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NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they are
10.310.2 pins respectively. Additionally although the serigraphy only is expressed for the RS485 it
is also the same for the RS232. So if it is desired to enable any of the Hardware Serial connection
this is the function of these switches. See chapter 8 for more information

- «—> [103 | RS485/RS232HS | 10.2 | RS485/RS232 HS

8. Switch configuration

8.1  General Switches Configuration

LEFT ZONE.
Communications and inputs/outputs cannot work simultaneously.

LEFT ZONE

SWITCH OFF ON

DE-RS485 A0.2-Q0.2* | DE-RS485

D10/A0.2-Q0.2 | DE-RS485 | A0.2-Q0.2

RE-RS485* | A0.1-Q0.1* | RE-RS485

D11/A0.1-Q0.1 | RE-RS485 | A0.1-Q0.1*

SDA-D2/10.0* SDA-D2 10.0

SCL-D3/Q0.6* | SCL-D3 Q0.6

*12C switch serigraphy is turned around. It should be: (SDA-D2 , SCL-D3). RX-RS485 should be RE-RS485

6. DE-RS485 — If this switch is ON, the A0.2-Q0.2 switch must be set to OFF. Being in ON mode
it enables DE for the RS-485.

5. A0.2-Q0.2 - If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode
it enables the outputs A0.2-Q0.2.

4. RE-RS485 — If this switch is ON, the A0.1-Q0.1 switch must be set to OFF. Being in ON mode
it enables EE for the RS-485.

3. A0.1-Q0.1 — If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode
it enables the outputs A0.1-Q0.1.

2. SDA-D2/10.0 — Choosing between SDA (12C) / Pin2 and 10.0. If this switch is ON, the 10.0 input
will be enabled and the SDA / Pin3 will be disabled. If this switch is OFF, the SDA / Pin2 will be
now available and 10.0 disabled.
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1. SCL-D3/Q0.6 — Choosing between SCL (12C) / Pin3 and QO0.6. If this switch is ON, the Q0.6

input will be enabled and the SCL / Pin3 will be disabled. If this switch is OFF, the SCL / Pin3 will
be now available and Q0.6 disabled.

TOP ZONE
SWITCH OFF ON
10.3 RS485/RS232 HS 10.3

RS485/RS232 HS

10.3

RS485/RS232 HS

10.2

RS485/RS8232 HS

10.2

RS485/RS232 HS

10.2

RS485/RS232 HS

TOP ZONE

i

NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they
are 10.3 10.2 pins respectively. Additionally although the serigraphy only is expressed for the

RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial

connection this is the function of these switches. See chapter 8 for more information

+—>

103 | RS485/RS232 HS [ 10.2 | RS485/RS232 HS

1. 10.3: If this switch is ON, the RS485/RS232 HS switch must be set to OFF. Being in ON
mode it enables 10.3.

2. RS485/RS232 HS: If this switch is ON, the 10.3 switch must be set to OFF. Being in ON
mode it enables the DO for the RS-485 or RS-232 Hardware Serial (see section 9 for
jumper configuration)

3. 10.2: If this switch is ON, the RS485 switch must be set to OFF. Being in ON mode it

enables 10.2.

4. RS485/RS232 HS: If this switch is ON, the 10.2 switch must be set to OFF. Being in ON
mode it enables the D1 for the RS485 or RS-232 Hardware Serial (see section 9 for
jumper configuration
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RIGHT ZONE SWITCH

RIGHT ZONE
SWITCH OFF ON

H/F Full Duplex Half Duplex

Q0.6 ANALOG (A0.6) DIGITAL (Q0.6)
Q0.5 ANALOG (AO0.5) DIGITAL (Q0.5)
Q0.4 ANALOG (A0.4) DIGITAL (Q0.4)
Q0.3 ANALOG (A0.3) DIGITAL (Q0.3)
Q0.2 ANALOG (A0.2) DIGITAL (Q0.2)
Q0.1 ANALOG (A0.1) DIGITAL (Q0.1)
Q0.0 ANALOG (A0.0) DIGITAL (Q0.0)

RIGHT ZONE. The right zone configures the outputs. If the switch is set to “ON” the Q0.X will
have the behaviour of a digital output. If it is set to “OFF” it will be analog. There is also a
switch for switching between Half and Full Duplex. It is “ON” for Half Duplex and “OFF” for Full

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE
must be configured as it is shown in the table.
Although the switch serigraphy is only referenced to RS-485 it is also the

OFF Having this setup, the 10.3 & 10.2 are disabled

RS-485 LEFT ZONE: In order to enable the RS-485 communication
protocol it is necessary that the switches of the left zone are
configured as it is showed in the table.

The ones marked with “-“ mean that they don’t affect the RS-485
communication protocol

Duplex.
8.2 RS- 485 Switch configuration
TOP ZONE
SWITCH | MODE
10.3 OFF
for the RS-232.
RS485 HS ON
10.2
RS485 HS ON
LEFT ZONE
SWITCH CONFIGURATION
SWITCH MODE
DE-RS485 ON
D10/A0.2-Q0.2 OFF
RE-RS485 ON
D11/A0.1-Q0.1 OFF
SDA-D2/10.0
SCL-D3/Q0.6
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8.3

RS-232 Switch configuration

RS-232 TOP ZONE: In order to enable the RS-232 communication protocol it is

TOP ZONE
SWITCH | MoDE | hecessary that the switches of the top zone are configured as it is shown in
10.3 OFF the table.

RS232 HS ON

10.2 OF

F

RS232 HS ON

Although the nomenclature is not referenced to the RS-232, this switches
relates the hardware serial of the Arduino board.

LEFT ZONE

RS-232 LEFT ZONE: In order to enable the RS-232 communication protocol

SWITCH | MODE

it is necessary that the switches of the left zone is configured as it is

showed in the table.

The ones marked with “-“ mean that it does not affect the RS-232

communication protocol

DE-RS485 OFF
D10/A0.2-Q0.2 ON
RE-RS485 OFF
D11/A0.1-Q0.1 ON
SDA-D2/10.0 -
SCL-D3/Q0.6 -

8.4 12C Switch configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
10.3 - DE-RS485 -

RS485/RS232 HS

- D10/A0.2-Q0.2 -

10.2

- RE-RS485 -

RS485/RS232 HS

- D11/A0.1-Q0.1 -

SDA-D2/10.0 OFF

SCL-D3/Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0
and Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up
resistor (IS.ACI2C-4.7K) is required.
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9. Jumper Configuration

General Jumper Configuration

JUMPER ZONE 1
LEFT RIGHT
RS-485 RS-485
DO D1
RS-232 RS-232
JUMPER ZONE 2
LEFT RIGHT
10.2 10.3
D4 D8
RS-232 SS RS-232 SS

This jumper makes the choosing between connecting MAX232 to pins
0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to
the D1/DO0. In order to use the RS-485 Hardware Serial protocol both
RS-485 must be connected to the D1/DO0.

This jumper zone makes the choosing between connecting the inputs
10.2, 10.3 to pins 4 and 8 of the Arduino Leonardo respectively, or
connect the RS-232 ports to activate the Software Serial RS-232. In
order to use the inputs 10.2,10.3 the jumper must be connected to the
pins 4 and 8. So 10.2 must be connected with D4 and 10.3 must be
connected to D8.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected anywhere.

L X
RS-485

HARDWARE
SERIAL

L X
RS-232

SOFTWARE
SERIAL

RS-232 Digital
HARDWARE outputs
SERIAL 0.8

Q0.9
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10.

Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF

will be:

Switch configuration:

TOP ZONE LEFT ZONE
SWITCH | MODE SWITCH | MODE
10.3 OFF DE-RS485 ON
RS485 HS ON D10/A0.2-Q0.2 | OFF
10.2 OFF RE-RS485 ON
RS485 HS ON D11/A0.1-Q0.1 OFF
SDA-D2/10.0
SCL-D3/Q0.6
Jumper configuration:
JUMPER ZONE 1 SUNPER ZONE 2
LEFT RIGHT LEFT RIGHT
RS-485

DO

RS-485 10.2 10.3
D1 D4 D8

Having configured Ardbox Analog HF as it is shown above, these are the features that are

available:

o Available communication protocols:

Hardware Serial RS-485.

12C *If 12C is active 10.0 & Q0.6 are disabled
GPRS

TTL

USB

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled
o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using 12C A0.6 is disabled
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10.2 Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF

will be:

Switch configuration:

Note: The switches of the left
zone of the RS-485 don’t
interfere in the RS-232 HS, the
thing is that as pins 0 & 1 are
reserved for the RS-232, the RS-
485 is totally disabled. As it is
disabled, there is no point on
configuring these switches as
RS-485 mode

LEFT ZONE
TOP ZONE SWITCH MODE
SWITCH | MODE DE-RS485 | OFF
10.3 OFF D10/A0.2-Q0.2 | ON
RS232 HS ON RE-RS485 | OFF
10.2 OFF D11/A0.1-Q0.1 | ON
RS232 HS ON SDA-D2/10.0 -
SCL-D3/Q0.6 -
Jumper configuration:
JUMPER ZONE 1 HALF DUPLEX JUMPER ZONE 2
LEFT RIGHT LEFT RIGHT
_ R 10.2 103
DO [] D1 D4 [] D8
RS-232 RS-232 ] }

o Available communication protocols:
e Hardware Serial RS-232.

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled

12C
SPI
TTL
USB

*|f 12C is active 10.0 & Q0.6 are disabled

o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using 12C A0.6 is disabled
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11. GPRS/GSM

The SIM80OL module is the integrated module for the use of GPRS / GSM in this PLC and to
program it you must download this library on your Arduino IDE.

You can test the GPRS / GSM functionality using the examples that come with the library:

New

Open...

Open Recent
Sketchbook
Examples
Close

Save

Save As...

Page Setup
Print

Preferences

Quit

Ctrl+N
Cul+0

Ctrl +W
Cul+5
Ctrl +Shift+5S

Ctrl +Shift+P
Ctl+P

Cil+Comma

Ctl+Q

A
Robot Motor

sSD

Servo
SpacebrewYun
Stepper
Temboo
WiFi101
RETIRED

Examples for M-Duino family
EEPROM

Ethernet

RS-232

RS-485

RTC

SoftwareSerial

SPI

Wire

Examples from Custom Libraries
Adafruit FONA Library

Adafruit GFX Library

Adafruit RABBTS

DallasTem perature

Ethernet2

HX711-master

OneWire

VOO N Y W N e e

1=

Rev. 0: 30-08-2019

=
<

FONA3G_setbaud
FONA_SMS_Response
FONAtest

FONAtest KEY_mod
GPS

IncomingCall

When defining the pins in the program, take into account that the internal connections

between the Sim800l module and the Arduino Mega are the following:
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Arduino Leonardo Pinout Sim800L Pinout

5Vdc Vce
GND GND
MISO TxD
MOSI RxD
Pin 2 GPRS RESET

The GPRS/GSM protocol is always enabled as there are no switches that configure it.

the GPRS / GSM protocol uses the SPI pins of the equipment to be able to communicate and
the pin2 for the module reset.

If you want to use the SPI pins, you must indicate in the program that pin2 is always in High
position. In case of using the SPI, the GPRS / GSM communication can not be used.

12. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

M-Duino terminal Arduino pin
SCL—Pin 3 3
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.
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11.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the I12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with

these pins.

11.2 Pin3

Pin3 is only referred to the input R5. If the switch configuration is in OFF position the pin Pin3
will be available.

This pin is not stablished with a pull-up or pull-down configuration. The state of pin 3 is
unknown. If using pin3, it requires a pull-up or a pull-down configuration. The Arduino board
allows pin 3 to be set in a pull-up configuration. If not it must be stablished an external pull-up
or pull-down circuit in order to correctly work with this pin.

11.3 SPI - MISO/MOSI/SCK

These pins are used for the GPRS module.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established an external pull-up or pull-down circuit in order to correctly work with

these pins.

13. 1/0 technical details

Digital Output Waveform

9+7244, Gnz || g———————————
v

DIGITAL OUT

M Z2EEms CH1 ¥ ZE@ml)
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Digital Output Turn-off

DIGITALOUT

PWM Waveform

PWHM OUTPOUT

|
|
|

i
=

i

v

ANALOGOUT
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Analog Out Turn-off

ANALOG OUT
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14. Typical Connections

:/ o 0.0 oy

Ferrite KITA

3
rm: 10 POWER
2/24v B oomaw
SHIELDED CABLE J:IWA

nr

T

ermrite KITA

st @j B POWER
228V B oomwawoow
SHIELDED CABLE a Dumalend 0 MR LAY \

32



Re . 0: 30-08-2019

-—0%0— 0.7

Ferrite KITA

@:‘:" ol )m': DRUTALANALOG B0

Dommioed e MOUING LAYOUT:
SHIELDED CABLE / Froem: ‘\

SHIELDED CABLE

ﬁimmwjg
PN
T oo ALWAYS
CONNECTED
&

VOUT = @/ Vde

5

* See ihe switch
configutirian (O]

ALWAYS

Ferrite KITA

SHIEL VOUT = Q/ Vide

SHIELDED CABLE/

LV .
SHIELDED CABLE
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E
\

Ferrite KITA -

POWER
E ANALOG OUT
SHIELDED CAE!LEI;' mﬂnmum

¢ 1
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* See the switch
configutarion (OFF)

i | Y o-1w)

SHIELDED CABLE
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15. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For I/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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16.

19

114

17.

101

ARDBOX Family Dimensions:

45mm width

DIN rail mounting:

Rev. 0: 30-08-2019

Profilato o cappello TH 35-7,5
Top hat rail TH 35-7,5

Profilato o cappello TH 35-15
Top hat rail TH 3515

15 5
1535
1004
15°
I RO8
=03 L
3 _l
S 1004
v Sezione A / Section A A

0.3 mox in_ fi
% . I 2,2 min. finoa / To 2,5 max

< Sezione A / Section A
CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS  BLEND
DI MISURAPUABS METHOD PUABS
Meccaniche k KTMDE8 WP ] Mechanical test Res i yild ASTMDE3E MRy 8
oty KSTMDS3  MPo 4 Tnglesongth ASTADG3S NPy 4
Ay KADSH % ] Jimon o ASTDES % ]
Modulo inf KSTADIN0 WPy 2894 Hing moduls ASTHDT0 MRy 2894
d L 5018004 W' 55 rod tst roiched 1S0180/14 W' 55
Termiche i I A 114 Thermal test  Viaot sodtni thod ASTMDISS 114
Tomperotg it 1 81 MPy KTADE4S  °C 9 Rebecting bmperctys 181 MPg ASMDSE 9
Fisiche i 1 Physicol fest  Spaciic govity ASTHD7R? g3 121
i el SIMDSS % 0408 Mould siinkoge ASTAD9SS % 0406
Mt Flow Indox 260°C - 98N KSTADIZE  g/10° 111 Mt Flow Index 260°C - 98N ASTMDIZEE 10" 111
Comportamento Aunesinguerza (mm di spessor) ne v-0(08) Flame test Sef atinguisher hidoess in mm) 194 - V0(08)
i 9521 °C 90 thood 32 mm Ig9521 9%0

Italtronic si riserv il diito di modificore il matericle con cui realizo i propri prodotti

senzo obbligo di preowviso.

Iraltronic con operate ony change of the moteriols without being obliged to forewam.
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18.

Revision Table

Revision
Number
0

Date

03 /07 /2019

Rev. 0: 30-08-2019

Changes

It was first implemented
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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